
File Manager Jr.
For Version 6.0 of Microsoft® Word for Windows™

File Manager Jr. comes in a smaller package than the Windows File Manager but 
performs many of the same functions.  Only faster.

Using File Manager Jr., you can quickly move, copy, delete and rename files 
without having to switch to the Windows File Manager.  You can also open 
existing files, delete all BAK files in a specified directory and print documents 
without having to open them.  You can create, rename and delete directories.  
And you can recover deleted files (if you have MS-DOS 6 or 6.2).

When you start File Manager Jr., you see the main menu.  It looks something like 
this:

The name of the main Word directory appears at the top of the directory list, in 
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the center of the menu.  The names of any Word subdirectories you have created 
for document storage appear below the name of the main directory.  Names of 
subdirectories preassigned by the developers of the Word program are also 
displayed.  The preassigned subdirectories include CLIPART, SETUP, TEMPLATE 
and WORDCBT.  File Manager Jr. treats the names of preassigned subdirectories as
reserved names.  If a subdirectory has a reserved name, you can’t use File 
Manager Jr. commands to work with files in that subdirectory.

Conventions used in this guide
Word subdirectories created for document storage are referred to as “document 
directories.”  Examples: C:\WINWORD\PERSONAL and C:\WINWORD\REPORTS 
would be document directories.

Directories created as branches of document directories are referred to as 
“document subdirectories.”  Examples: C:\WINWORD\PERSONAL\NOTES and C:\
WINWORD\REPORTS\SALES would be document subdirectories.

Names of File Manager Jr. commands appear in boldface.  Filenames and 
directory names appear in small capitals.  Words that the user is to type appear in 
small bold capitals.  Section titles are boldfaced when cited in the text.

More about the main menu
Commands in the left-hand column share a box with the directory names are used
in combination with those names.  Examples:

Mouse   To open a file in a document directory called C:\WINWORD\PERSONAL, 
first click the Open button in the left-hand column.  Then double-click the name 
PERSONAL in the directory list.  A file list appears.  Double-click the name of the 
file you want to open.

Keyboard   To delete a file in a document directory called C:\WINWORD\
REPORTS, first select the Delete button by pressing the D key.  Then highlight the 
name REPORTS in the directory list and press Enter.  A file list appears.  Highlight
the name of the file you want to delete.  Press Enter.

Additional illustrations:

Mouse   It’s important to distinguish between double-clicking and single-
clicking names in the directory list:

If you select a command button on the left and then double-click a directory 
name, the command you selected is set in motion at once.  Example: If you select 
the Open button and then double-click the name PERSONAL in the directory list, 
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the program immediately displays a box listing the files in the PERSONAL 
directory.

If you select a command button and then click a directory name once instead of 
twice, the selected command is not set in motion.  The directory name is merely 
highlighted.  When you want to access a file in a document subdirectory, click a 
directory name just once and then click the Show Subdirectories button.  
Example: You want to delete a file in C:\WINWORD\REPORTS\SALES.  Procedure: 
Select the Delete button.  Single-click REPORTS in the directory list.  Then click 
Show Subdirectories.  A list of subdirectories appears.  Choose the name of the 
SALES subdirectory.  Then choose the name of the file to be deleted.

Keyboard   How you access a file depends on whether the file is stored in a 
document directory or a document subdirectory.

If the file is stored in a document directory, select a command button, highlight a 
name in the directory list and press Enter.  The selected command is set in motion
at once, just as if you had double-clicked the directory name.

If the file is stored in a document subdirectory, select a command button and 
highlight a name in the directory list.  Do not press Enter.  Instead, choose the 
Show Subdirectories button by pressing Tab and then the letter S.  (You may find
it faster to use the mouse to access files in document subdirectories.)

General   If you select a command button at the left and then discover that you 
picked the wrong button, you can override the selection.  Example: If you intend 
to select the Delete button but instead select Undelete, you can correct the 
mistake by clicking Delete.  Or you can start over by choosing the Home button.  
To choose Home using the keyboard, press Tab and then the H key.

At the far right on the main menu, a second column of commands appears in a 
free-standing box.  Commands in this box function independently.  Their 
operation has no connection with the directory list.  To run one of the commands 
in the box at the far right, just start File Manager Jr. and choose a command 
button.

If you select a command button in the left-hand column when you meant to 
choose one in the right-hand column, just click the button you meant to choose in 
the first place.  Or choose the Home button to start over.

To perform an operation on a file in drive A or drive B, first select a command 
button in the left-hand column.  Then choose the DRIV  E A or DRIVE   B button by 
clicking it or by pressing Tab and then the letter V or E.

A button labeled DRIVE X appears to the right of the drive B button.  The function
of DRIVE X is described later.   

Note    For brevity, most step-by-step examples given later in this guide omit 
keyboard directions.  Such directions appear only when procedures used 
to perform a keyboard operation have not been covered by earlier 
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examples.

File Manager Jr. commands
The Open command opens a previously saved file.  Examples:
To open a file stored in a document directory called C:\WINWORD\REPORTS, first 
select the Open button.  Then double-click the name REPORTS in the directory 
list.  An Open File dialog box appears.  Choose the name of a file to open.

To open a file stored in a subdirectory of the REPORTS directory, first select the 
Open button.  Then single-click the name REPORTS in the directory list and click 
the Show Subdirectories button.  In the next box, choose a subdirectory.  An 
Open File box appears so that you can choose the name of a file to open.

Although you’ll probably store most files in document directories or document 
subdirectories, you can use the Open command to access files stored in the main 
Word directory.  (You can use other File Manager Jr. commands to move, copy, 
delete, rename and print such files.)

Without opening any documents, you can use the Open command to get 
information about files.  Example: To see which files are stored in a directory 
called C:\WINWORD\PERSONAL, first select the Open button.  Then double-click 
the name PERSONAL in the directory list.  After checking the file list, click Cancel 
or press the Esc key to close the Open File box.

Note    A Back button appears in the Open File box, and in many other File 
Manager Jr. dialog boxes.  You can use the Back button to return quickly 
to the main menu when you open a dialog box by mistake.  Just click the 
button or press Tab and then the B key.  To close a box without 
redisplaying the main menu, click Cancel or press Esc.  (If no file list or 
directory list appears in a dialog box with a Back button, you can return to
the main menu by pressing B without first pressing Tab.)

·

The Move command transfers a file from one directory to another.  It will also 
move a file to or from a disk in a floppy drive.  Procedure: 

To move a file from a document directory, first select the Move button.  In the 
directory list, double-click the name of the directory containing the file to be 
moved.  A file list appears.  Choose a filename.

To move a file from a document subdirectory, first select the Move button.  In the
directory list, click a directory name once.   Then click the Show Subdirectories 
button.  Choose a subdirectory.  Then choose a filename.

To move a file from drive A or drive B, select Move and click the appropriate 
drive button.  Then choose a filename.

Once the file to be moved has been chosen, you see a list box labeled Destination.
To move a file to a document directory called REPORTS, double-click the name 
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REPORTS in the Destination box.

To move a file to a document subdirectory, single-click a directory name in the 
Destination box and then choose the Show Subdirectories button.  A list of 
subdirectories appears so that you can choose a destination subdirectory.

To move a file to drive A or drive B, click the appropriate drive button. 

After you move a document, the Move File box reappears so that you can move 
another document if you wish.  You can close the box by pressing Esc.

You can’t use the Move command to move an open document.

·

The Copy command creates a duplicate of a file and sends the duplicate to a 
destination of your choice, leaving the original copy of the file in place.  The 
command works much like Move.  One difference: You can copy an open file.

·

The Delete command erases a file.  It is structurally similar to the Open 
command.  After the command has been set in motion, a file list appears in a 
Delete File box.  Choose a filename.  After you erase a file, the Delete File box 
reappears so that you can erase another file if you wish.  You can close the box by
pressing Esc.

The Delete command won’t erase an open document.

·

The Kill BAKs command erases all BAK files in a specified directory.  To delete 
BAK files stored in a document directory, first select the Kill BAKs button and 
double-click a directory name.  To delete BAK files stored in a document 
subdirectory, select the Kill BAKs button, click a directory name once and then 
choose the Show Subdirectories button.  In the next box, choose a subdirectory 
name.

There must be no open BAK files in the targeted directory or subdirectory.

The command does not delete BAK files on floppy disks.  (When you select the 
Kill Baks button, the DRIVE A and DRIVE B buttons are dimmed and inaccessible.)

·

The Undelete command recovers erased files, using the Undelete for Windows 
program in MS-DOS 6.0 or 6.2.  First select the Undelete button.  Then choose 
the name of a directory or subdirectory just as you would if you were using one 
of the commands described earlier.

When the Microsoft Undelete window appears, select one or more filenames and 
click the Undelete icon.  To close the window, choose Exit on the File menu.

To tell DOS what level of file protection you want to use, choose the Undelete 
icon from the Microsoft Tools group in the Windows Program Manager.
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·

The Rename command changes the name of a file.  First select the Rename 
button.  Then choose the name of a document directory or subdirectory just as 
you would if you were using one of the commands described earlier.

When asked to enter a new name for a document, do not type a directory name or 
subdirectory name ahead of the filename.  Type the filename only.  Example: If 
the document is in the directory C:\WINWORD\MEMOS and you’re changing the 
name from ABLE.DOC to BAKER.DOC, don’t type C:\WINWORD\MEMOS\
BAKER.DOC.  Just type BAKER.DOC.

After you rename a document, the Rename File box reappears so that you can 
rename another document if you wish.  You can close the box by pressing Esc.

You can’t rename an open document.

·

The Print File command lets you print Word documents without opening them.  
Example: You’re working on a file in the PERSONAL directory and need a printout
of a file stored in the REPORTS directory.  Procedure: Select the Print File button.
Then double-click the name REPORTS in the directory list.  A list of the files in the
REPORTS directory appears so that you can choose the document to be printed.

You can also use the command to print a file stored in a document subdirectory.  
To view a subdirectory file list, proceed just as you would if you were executing 
one of the commands described earlier.

·

The Save New command is used to specify where a file will be stored when 
saved for the first time.  Example: If you want to store a new file in a document 
directory called REPORTS, select the Save New button and then double-click the 
name REPORTS in the directory list.

To store a new file in a document subdirectory, first select the Save New button.  
Then click a directory name once and choose the Show Subdirectories button.

When asked to enter a name for a new document, do not type a directory name or 
subdirectory name ahead of the filename.  Type the filename only.  Example:  If 
you’re naming a new file DOCK.DOC and storing it in C:\WINWORD\MEMOS, don’t 
type C:\WINWORD\MEMOS\DOCK.DOC.  Just type DOCK.DOC.

The command cannot be used to store a new file on a floppy disk.  (When you 
select Save New, the DRIVE A and DRIVE B buttons are dimmed and inaccessible.) 

·

The Get Stats command displays statistical information about files in a specified 
document directory or subdirectory. Example: You’re working on a file in the 
PERSONAL directory.  The file DOCK.DOC is stored in the MEMOS directory.  You 
want to know the size of DOCK.DOC and the date it was last saved.  Procedure:
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Select the Get Stats button.  Then double-click the name MEMOS in the directory 
list.  A Find File box appears, listing the files in the MEMOS directory.  Highlight 
the filename DOCK.DOC to display statistical information about that file.  If you 
want information about a second file, highlight another filename.  When finished,
press Esc to close the Find File box.

You can also get statistical information about files stored in a document 
subdirectory.  Just select the Get Stats button and then choose a subdirectory just 
as you would if you were using one of the commands described earlier.

· .

The Back Up command sends a copy of the active document to a backup disk in 
the A drive.  Any previous backup copy is overwritten.

If you want to use the B drive for backups instead of the A drive, choose the 
Setup button on the main menu.  Then choose the Change Backup Drive button.

Reminder: The Back Up command is in the far-right column on the main menu.  
Like other commands in that column, it does not act in combination with names 
in the directory list.  To run the command, simply choose the Back Up button by 
clicking it or by pressing the B key.

·

The Print Selection command prints a selected block of text.  First highlight the 
text you want to print.  Then choose the Print Selection button.  (The selected 
block of text must be at least two characters long.)

·

The Find File command helps you locate a file when you can’t remember where 
you stored it or can’t remember its name.  When you start the command, you’re 
asked whether you want to search for a filename or for text.  If you know the 
name of the file you’re looking for, choose the Filename button and type a name 
in the next box.  If the file is found, its directory is identified.  If you don’t know 
the name of the file you’re looking for, choose the Text button.  In next box, type 
a phrase that is likely to be found only in the file you’re looking for.  Important: 
Enclose the phrase in quotation marks.  And note: Finding text takes time.  Word 
has to search files line by line.

·

The File Info command displays a word count, a page count and other statistical 
information about the active document.

·

The Directory Mgr. command is used to create, rename and delete directories.  
For additional information, see More about Directory Mgr. later in this guide.

·

The Address List command places an inside address in a business letter.  The 
address is copied from a file in which you have stored names and addresses.  The 
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command is also used to print envelopes and to edit, browse and sort the address 
file.  For additional information, see More about Address List later in this 
guide.

·

The Junk Closet command is used to store text temporarily in a holding file or to
retrieve text from the holding file.  For additional information, see More about 
Junk Closet later in this guide.

·

The Quit Word command closes any open files and quits Word for Windows.  
Use the command when you want to make a quick exit.  If any open documents 
have been changed since they were last saved, the changes are preserved.

Note    If you have entered text in a new document but have not yet named the 
document, you’ll be asked to supply a name before quitting Word.

Drive X: A rest home for old files
If you have two hard drives, you can use your secondary hard drive for storage of
old files—files you don’t want to delete but would like to move out of your 
regular document directories to reduce clutter.  The DRIVE X button in the lower 
part of the main menu makes it easy to move old files to a secondary drive.

The letter X in DRIVE X can stand for any working hard drive.  If you have a C 
drive and a D drive, for example, you can tell File Manager Jr. to recognize the D
drive as DRIVE X.  You can then conserve space on C by storing old files on D.

First you need to assign a drive and directory to the DRIVE X button.  To begin, 
choose the Setup button on the right side of the main menu.  In the Setup box, 
choose the Drive X Setup button.  In the next box, type a drive identifier and a 
directory name.  Example: D:\OLDFILES.  If the directory you specify doesn’t 
exist, File Manager Jr. can create it.

After assigning a drive and directory to the DRIVE X button, you can use the Move
command to transfer old documents to DRIVE X.  Example: If you want to transfer
an old file from a directory called C:\WINWORD\PERSONAL, select the Move 
button and then double-click the name PERSONAL in the directory list.  A list of 
files appears.  Choose a filename.  When asked to specify a destination for the 
file, click the DRIVE X button.

Note    You can open, move, copy, delete, undelete, rename and print old 
documents stored in DRIVE X.  Example: If you want to open an old 
document, select the Open button and then click the DRIVE X button.
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More about Directory Mgr.
To set up a new directory, first choose the Directory Mgr. button.  Then choose 
the Create button.  In the next box, indicate whether you want to create a 
document directory or document subdirectory.  When asked to enter a name for 
the new directory or subdirectory, do not type a path ahead of the name.  
Example: If you’re creating a document directory called WOMBAT, don’t type C:\
WINWORD\WOMBAT.  Just type WOMBAT.

To rename a directory, first close any open document windows in that directory.  
Then run Directory Mgr. and choose the Rename button.  Follow the onscreen 
directions.

You can’t rename the main Word directory.

To delete a directory, first close any open files in that directory.  Then run 
Directory Mgr. and choose the Delete button.  Follow the onscreen directions.

If the directory you want to erase is not empty, File Manager Jr. displays a 
warning.

Note    MS-DOS won’t let you use certain characters in directory names.  File 
Manager Jr. disallows the following additional characters: the percent 
sign, the parentheses, the caret (^),  the ampersand (&), the braces ( {} ) 
and the swung dash (~).

More about Address List
When you choose the Address List button, you see a dialog box with four 
command buttons.  The first command is Copy.  It places an address block in a 
business letter, saving you the trouble of typing an inside address.  The block is 
copied from a file in which you can store frequently used addresses.  The file is 
called NAMELIST.FMJ.  It was placed in the main Word directory when you 
installed File Manager Jr.

To copy an address block, first place the insertion point anywhere on the top line 
of the body of your letter.  Then run Address List and choose the Copy button.  
You’ll be asked to type a name.  If you want to copy the address of an individual, 
type a surname. Example: If you’re writing to Horatio D. Blunt, type BLUNT.  If 
you want to copy a business address in which no individual is named, type the 
first word in the name of the business.  Example: If you’re writing to the law firm
of Hussler & Hassler, type HUSSLER.  (You may be able to save keystrokes by 
typing only the first four or five letters of a long name.)

The style you use for letters does not have to match the style used to set up your 
address list in the NAMELIST.FMJ file.  If the styles are different, address blocks 
imported with the Copy command are converted to your letter style.
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The second command in the Address List dialog box is Print Envelope.  If you 
have a business letter onscreen, you can use the Envelopes and Labels command 
on the Tools menu to copy the delivery address from the letter to an envelope.  
Sometimes, however, you may be unable to use that command because you’re 
mailing material without a cover letter.  Solution: If the recipient’s name is in 
your address file, you can still print an envelope quickly.  Just choose Print 
Envelope in the Address List dialog box and follow the onscreen directions.  

By default, the Print Envelope command uses the Courier typeface and does not 
print a return address on your envelopes.  You can override these defaults.  
Procedure:
On the main menu, choose the Setup button.  In the Setup box, choose Envelope
Setup.  First select a font and a point size.  When asked whether you want a 
return address printed, choose the Yes or No button.  If you choose Yes, Word 
will use whatever address it finds in your Mailing Address box.  To see what’s in 
that box, choose Options on the Tools menu and click the User Info tab.

The third command in the Address List dialog box is Edit/Browse.  Use it when 
you want to open the address file so that you can add addresses, delete addresses 
or just browse.

When you choose the Edit/Browse button, you’re asked where you want to start 
in the address file.  Choose a letter.  The command searches for the first listing 
under that letter.

If you’re entering a new address listing, follow this form:

Blunt*Horatio D.
Blunt Instruments Limited
12345 Sixth Street
San Lardo, California 90000-0000
Mr. Blunt
408-000-0000

The person’s last name comes first.  Next comes an asterisk.  No space is left 
before or after the asterisk.  Do not use an asterisk anywhere else in a listing.  

When a listing is copied to a letter, File Manager Jr. rearranges the first line and 
removes the asterisk.  Example:

Horatio D. Blunt
Blunt Instruments Limited
12345 Sixth Street
San Lardo, California 90000-0000
Dear Mr. Blunt:

The “Mr. Blunt” in the salutation is copied from the next-to-last line of the 
Horatio Blunt address listing.  If that line were changed from “Mr. Blunt” to 
“Horatio,” the address would be copied with a “Dear Horatio:” salutation.  A 
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salutation name is entered on the next-to-last line of each listing.  The name must 
not be omitted.

The last line of each listing is reserved for a phone number and remarks.  
Example:

212-000-0000. Stanford grad. Birthday: 6/15. Wife: Gloria.

It’s OK to use more than one line for remarks, but the remarks must be confined 
to a single paragraph.  Do not press Enter between remarks.

If you don’t have a phone number for someone on your list and no remarks are 
needed, type several zeros on the phone-number line.  Do not omit the line.

When an abbreviation such as “M.D.,” “Esq.” or “Jr.” is used on the top line of an
address listing, it is treated as an extension of the last name and is entered before 
the asterisk.   

Correct form:  Flapdirdle, M.D.*Clyde C.
Incorrect form:  Flapdirdle*Clyde C., M.D.
If a last name consists of two or more words, the asterisk goes after the last of 
those words.  Example:

Van der Flatt*Vanessa C.
Chief Executive Officer
Van der Flatt Tire Corporation
700 Avenue of the Aleutians
New York, New York 10000-0000
Ms. Van der Flatt
212-000-0000

If you use a courtesy title such as “Ms.” or “Mr.” on the first line of a listing, 
place the title just after the asterisk.  Example:

Van der Flatt*Ms. Vanessa C.

When a listing begins with the name of a firm rather than with the name of an 
individual, follow this form:

Hussler & Hassler*
Attorneys at Law
Jarndyce Center
123 Fourth Street
Hacksaw, Texas 75000-0000
Counselors
509-000-0000

Notice that the asterisk appears at the end of the first line of the listing, after the 
name of the law firm.  (The full name of the firm is treated as a surname.)
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A listing may run five to seven lines.  The Hussler & Hassler example runs seven.
Here is an example of a five-line listing:

Cartwright*Mr. Crispin C.
1234 Fifth Street
Bounding, Maine 04000-0000
Mr. Cartwright
207-000-0000

Important: Leave one or two blank lines below each listing.

After entering one or more new listings, choose Close on the File menu and 
answer Yes when asked whether to save changes.  Follow the same procedure 
after deleting one or more listings.

Note    Eleven blank lines have been placed at the top of the address file.  They 
should not be removed.  Several fictitious address listings have been 
entered in the file for illustrative purposes.  They may be deleted.

The Edit/Browse command can also be used to look up information in the 
address file.  Example: If you need the telephone number of Horatio Blunt, run 
Address List and choose the Edit/Browse button.  Then choose B.  The insertion
point appears before the first listing under that letter.  After finding Blunt’s phone
number, quit the address file by choosing Close on the File menu.

The last command in the Address List dialog box is Sort.  It alphabetizes address
listings.  When you add listings using the Edit/Browse command, you don’t need
to jump around in the address file to get each new listing in its proper alphabetic 
position.  Enter listings in any order, anywhere in the file.  When finished, save 
the file and use Sort to put the listings in proper order.

You don’t have to sort the address list before copying an address to a letter or 
envelope.  It makes no difference to the Copy and Print Envelope commands 
whether the list is sorted.  But a sorted list is easier to work with when you’re 
browsing.

More about Junk Closet
The Junk Closet command is used for storage of text you want to remove from 
the active file but keep available for possible use later.

To store a block of text in the junk closet, first select the text.  Then run Junk 
Closet and choose Store Selection.  The text is sent to a file called JUNK.FMJ.  
The file was placed in the main Word directory when you installed File Manager 
Jr.

To find text in the junk file, run Junk Closet and choose Open Closet.  A Find 
dialog box appears.  Type a word or phrase peculiar to the block of text you’re 
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looking for.  Then press Enter.  If the junk file is small and you don’t need to run 
a search, press Esc to close the Find box.

To retrieve a block of text from the junk file, first select the text and place it on 
the Windows Clipboard.  Then close the junk file and copy the text from the 
Clipboard to the active file.

When you open the junk file, text in that file is displayed in whatever style you’re
using in the active document.  Result: You won’t need to apply your current style
to text imported from the junk closet.  The style will already have been applied.

A separator mark appears before each block of text stored in the closet.  That 
makes it easy to tell where one block ends and the next begins.

To delete text from the junk file, first execute Junk Closet and choose Open 
Closet.  Then select the text you want to erase and press the Delete key.  Choose 
Close on the File menu and answer Yes when asked whether to save changes.

Input boxes
An input box is a dialog box in which you type information.  File Manager Jr. 
uses many such boxes.  It may display an input box, for example, so that you can 
type a filename or directory name.  When finished typing, you can choose the OK
button by clicking it or by pressing Tab and then Enter.  If you press Enter 
without first pressing Tab, the cursor moves down a line and becomes improperly
positioned.  If you then try to choose OK by pressing Tab and Enter, an error 
message appears.

Tip      If you press Enter prematurely, use the Backspace key to put the cursor 
back where it belongs, just after the last character you typed.  Then press 
Tab and Enter.    

Assigning File Manager Jr. to a shortcut key
1. On the Tools menu, choose Customize.

2. In the Customize dialog box, click the Keyboard tab (at the upper right).   

3. In the Categories list box, click Macros.

4. In the Macros list box (to the right of Categories), click FileMgrJr.

5. Click the box labeled Press New Shortcut Key.  Press a shortcut key or a 
shortcut-key combination.  Example: If you want to be able to start File 
Manager Jr. by holding down Ctrl and striking J (for “Junior”), press the 
Ctrl key and, without releasing it, press J.

6. Choose Assign.

7. Choose Close.

File Manager Jr. / 1313



Assigning File Manager Jr. to a toolbar button
· On the Tools menu, choose Customize.

· In the Customize dialog box, click the Toolbars tab (at the upper left).

· In the Categories list box, click Macros.

· In the Macros list box (to the right of Categories), click the name FileMgrJr. 
and keep the left mouse button depressed.  A rectangular outline appears.  
Drag the outline to a position on the toolbar and release the mouse button.

· In the box labeled Text Button Name, type a short name, such as JR.

· Choose Assign.

· Choose Close.
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Manager Jr. and offered helpful criticisms.  His assistance is gratefully 
acknowledged. 

Registration information
File Manager Jr. is a shareware program.  You’re required to register the program
if you continue to use it after a 30-day trial period.  You can become a registered 
user by paying a fee of $15 to the author, Charles Maher, 409 North 18th Street, 
Coeur d’Alene, Idaho 83814-5460.  If you have a MasterCard or Visa account, 
you can call toll-free to register.  To register by voice phone, dial 1-800-215-3688
between 8 a.m. and 3 p.m. Pacific time.  If you have a modem, you can use a 24-
hour number: 1-800-503-2292.  Indicate that you are registering a product 
developed by vendor 3864.

For more about terms of use, see the file LICENSE.FMJ in the main Word directory.
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